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Introduction

This Rational ProjectConsole tutorial has a modular design so that you can complete sections or skip sections, based on the development tools your team uses and how you plan to use Rational ProjectConsole.  This section is provided for Rational ProjectConsole administrators who want to learn the basic steps for collecting data in the form of text from sources that are not supported by Rational Suite Extensibility (RSE).  Although Rational ClearCase is the source from which text is collected in these exercises, you can use the same procedures to collect text from Rational Purify, Rational Quantify, or Rational Pure Coverage. 

Overview of data collection

Using Rational ProjectConsole to collect data from any development tool involves the following high-level tasks: 

1. Identify a source.  Rational ProjectConsole can extract artifacts directly from the repositories of developments tools supported by RSE. RSE-supported tools include Rational ClearQuest, Rational RequisitePro, Rational Rose, and Microsoft Project.  For development tools that are not supported by RSE, such as Rational Purify, Rational Quantify, Rational PureCoverage, and Rational ClearCase, Rational ProjectConsole provides collection “agents” that can parse data text files.

2. Specify the data to extract from the source.

3. Define a warehouse schema (create the target tables) to store the source data.

4. Define a mapping that identifies where the source data will be stored in the warehouse tables.

5. Define a collection task.  (Collection tasks can also be set up to run on a predefined schedule.)
6. Run the collection task.

7. View the results.

PC setup

Install and configure the Rational ProjectConsole sample site as described in IBM Rational ProjectConsoleInstallation and Upgrade Guide. 
The following directory references are used throughout the tutorial:  

· InstallDir refers to the installation path for Rational ProjectConsole (C:\Program Files\Rational\ProjectConsole is the default path).
· ClassicsDir refers to the installation path for the Classics sample application (C:\Classics is the default path).

Configuring Rational ProjectConsole to collect Rational ClearCase metrics

In this section of the Rational ProjectConsole Tutorial, you will learn how to set up Rational ProjectConsole to collect Rational ClearCase data.  If this is the first section of the tutorial you are completing, see Section 0 – Setting Up for the Tutorial before you start these exercises. 

This section also requires that you do the following before you begin the exercises: 

1. If you do not have a C:\temp directory, create one.

2. Copy InstallDir\sample_db_files\ccdata.txt file to the C:\temp directory.  

Overview of Rational ClearCase data collection

Collecting data from Rational ClearCase is a two-step process:

Step 1:  Run a Perl script called “ClearCaseData.pl” to extract data from Rational ClearCase and save it in a text file.

Step 2:  Load the data from the text file into the Rational ProjectConsole data warehouse.

Step 1

Set up your Rational ClearCase view.  You can use a dynamic view or a snapshot view, although using a snapshot view is faster. Accessing a dynamic view involves more network traffic.  When you create your snapshot view, select only the VOBs from which you want to extract data.  If you are using a dynamic view, only mount the VOBs from which you want to collect data.

Use the script called ClearCaseData.pl (located in your InstallDir\bin directory) to extract the data from Rational ClearCase as follows:

From a command prompt, run the following command:

cqperl ClearCaseData.pl <parameters>

where the parameters are:

view=<path> - Top level directory of the view (required)

out=<path> - Location of the output text file (fully qualified path) (required)

since=<start date> - Starting point for the history data (optional)

For information about the exact format to use, see the ClearTool documentation.
debug=1 - Turns on debug tracing (optional)

Example: 

cqperl ClearCaseData.pl view=C:\snapshot_sample out=C:\temp\ccdata.txt

To automate this task, type the preceding command in the Startup Commands box in the Scheduled Task window. (For this section of the tutorial, we’ve provided a sample text file called ccdata.txt that contains data extracted from a Rational ClearCase VOB so you aren’t required to perform this step.) To collect Rational ClearCase data regularly, run this script as a startup command for the collection task without a “since” argument. 

On the first run, the script collects the history information for all VOBs accessible through the view, up to the moment of collection. It also creates a directory called vobs in InstallDir\logs and adds one file per VOB in this directory (the file name is the VOB tag). This file contains the date and time the script started to run for the specified VOB. This allows for tracking of incremental changes without duplicate data; the next time the script runs, it uses this timestamp as its “since” argument value. 

Step 2

Create a text source template, a mapping, and a scheduled task. Make sure that the “SourceInstance” parameter for the scheduled task matches the ‘out’ parameter of the Perl script.

Creating a source template for collecting Rational ClearCase data

In this first exercise, you will create the source template for your Rational ClearCase data collection. 

	
	Use case steps
	Details
	Display

	4.1.1 
	Start your Web browser and log in to the Rational ProjectConsole Web site.  

Note You can log in to the Web site from the Rational ProjectConsole Web server or from a client.
	Start your Web browser, and then type the following URL:

http://server_machine/projectconsole

where server_machine is the name of your Rational ProjectConsole Web server.
	

	4.1.2 
	
	In the User ID box, type “admin.”

In the Password box, type “changeit.” 
Click Log In.
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	4.1.3 
	
	The welcome page for the sample project ClassicsCD.com is in the right pane. 
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	4.1.4 
	Start the Rational ProjectConsole Designer.


	On the Rational ProjectConsole toolbar, click Designer.
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	4.1.5 
	
	The Designer starts in a new browser window.
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	4.1.6 
	To begin setting up the Rational ClearCase collection, create a text source template.
	On the Designer File menu, point to New, and then click Text Source Template.

Alternatively, on the Designer toolbar, click Create Text Source Template.
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	4.1.7 
	Name the new text template.
	The source template designer window is in the right frame.

On the General Page tab, in the Name box, select the default name, and then type 
“CC Template.”

Click the Source Fields tab.
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	4.1.8 
	Specify the name of the machine from which the text file will be accessed.


	On the Source Fields tab, next to the Host Name box, click Select.
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	4.1.9 
	
	In the Hostnames list, select <ProjectConsole Server> to run the Rational ClearCase data collection. 
Click OK.
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	4.1.10 
	Select the text file.

The text file is an example of the type of data that you will collect from Rational ClearCase.
	On the Source Fields tab, next to the Text File box, click Select.
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	4.1.11 
	The Select Template window lists all text files stored in the InstallDir\templates\Designer directory.
	In the Templates list, select ccsample.txt.

Click OK.
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	4.1.12 
	Create a record type for the ccsample.txt text file.
	On the Source Fields tab, next to the Records table, click Add.
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	4.1.13 
	Name and define a record type.


	In the Record name box, select the default record name, and then type “ClearCase Data.”

The Lines list displays the contents of the ccsample.txt file. Each line represents one Rational ClearCase artifact.

In the Lines list, double-click the first line.
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	4.1.14 
	Select Tab as the text delimiter.


	In the Delimiter list, select Tab.

After you select the delimiter, the Tokens table is populated. It displays one token per row.
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	4.1.15 
	Make ClearCase Data a keyword for this record type.
	In the Tokens table, select the Keyword check box for the ClearCase Data token name (the first token name listed).

This makes ClearCase Data a keyword for this record type
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	4.1.16 
	Create a source field in the record type for the operation date.
	In the Tokens table, the second token listed (2003-02-11) in the Token name column represents the operation date.

In the Tokens table, select the Source field check box for the second token name listed.

Click the Field name column for the second token name, and then type “operationDate.”
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	4.1.17 
	Create source fields for the tokens listed in positions 3 through 12.
	Repeat step 1.1.16 to create source fields for the following tokens:

Token name

Tokens table
position

Field name
value

elarsen

3

userName

checkin

4

operation

version

5

artifactType

K:\dash\install\ pjc.xml

6

name

dash

7

vob
\main\pjc_mck_ integration

8

branch

53

9

version

1

10

linesChanged

2

11

linesInserted

0

12

linesDeleted

After you specify these source fields, the ClearCase Data record type is defined.

Click OK.
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	4.1.18 
	
	On the Source Fields tab, the Records table lists the ClearCase Data record type that  you created.
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	4.1.19 
	Save the source template. 
	On the Designer File menu, click Save. 

Alternatively, on the Designer toolbar, click Save.
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	4.1.20 
	After you create and save a domain source template, Rational ProjectConsole can automatically create all of the metadata (target tables, a mapping, and a collection task) required to use the template for data collection. 

In this exercise, however, you will create the metadata manually.
	Click No.
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	4.1.21 
	Close the source template properties window.
	In the right frame, close the CC Template window.

Leave the Designer open.
	


Part 2 –  Defining measure tables and fields

In this exercise, you will create the warehouse tables that the collected Rational ClearCase data will populate.

	
	Use case steps
	Details
	Display

	4.2.1 
	Adding or updating warehouse tables changes the warehouse schema. Before you create new warehouse tables, you must first check out the schema.
	On the Schema menu, click Check Out.

Alternatively, on the Designer toolbar, click Check Out.
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	4.2.2 
	You can enter comments about the check-out you are performing.
	In the Comments box, you can enter information about the schema check-out.

Click OK.
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	4.2.3 
	Acknowledge the schema 
check-out.
	A message is displayed to let you know the schema was checked out successfully.

Click OK.
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	4.2.4 
	To set up a warehouse schema for a collection, you first define the dimension tables, and then define the measure table. 

In this exercise, you’ll create five new dimension tables, a time dimension table, and a measure table.

To start, create the first dimension table to store Rational ClearCase branch information.
	On the Designer File menu, point to New, and then click Dimension Table.

Alternatively, on the Designer toolbar, click Create Dimension Table.
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	4.2.5 
	Rename the new dimension table.

Tip  Although it is not required, using  a naming convention for target tables is a good practice.  The naming convention used here is to append “_Dim” to designate a dimension table.
	On the General tab, in the Name box, select the default name, and then type “CCBranch_Dim.”

Click the Target Fields tab.
	[image: image25.png]| Fie i vew ravrtss ok b

| wback > - @[3 4| Qeearch (alrvortes (Sristory | BN+ S B -
| address [&1 hitp:jmem2ksp3fprojectconsolejmain?USE_CASE=dashboardtaction=launchDashboardDesigner ] @oo ||unks 7
Fie Vew schema Tek Tme window reb

=
J@|xd@|nlensn« ==au)el

Snaranouse -
NewTargetTable71968520%

Gonera | rnge s |
Schectied Tasks
B Schecuiea Tk Logs

e [Eceranch o]

Type : Dimension

Descrigion

&1 Loadng Java Appet

Hstart ||| 1] @ || Byciclassics...| Fluntiied -paint | Cutiemcpitem... | SulemxpiTem... | CilimpiDL... | Ciliemspitem...| £Rational- .. [[EiRationalpr.. [ BEBHE  azrem






	4.2.6 
	The Designer creates a single field in a new dimension table.

Give this field a descriptive name.
	On the Target Fields tab, click the row that displays the name of the default target field, and then click Edit.
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	4.2.7 
	
	In the Name box, select the default field name, and then type “CCBranch.”

Leave all other default settings.

Click OK.
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	4.2.8 
	Save the CCBranch_Dim table and close the target table window.
	On the Designer File menu, click Save.

Close the CCBranch_Dim window.
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	4.2.9 
	Create three additional dimension tables for your Rational ClearCase collection.


	Repeat steps 1.2.4 through 1.2.7 to create the following dimension tables:  

Table Name

Field Name

CCOperation_Dim

CCOperation

CCVersion_Dim

CCVersion

CCVob_Dim

CCVob


	

	4.2.10 
	Verify that the Build_Dim table exists.

Separate warehouse schemas can make use of the same dimension tables. If an existing table has the correct table and field names, there is no need to recreate it.

In this example, you will reuse the Build_Dim table, which has already been created in the sample Rational ProjectConsole warehouse.
	In the Designer navigation tree (in the left frame), expand Target Tables, and make sure Build_Dim is listed.
	

	4.2.11 
	Create a time dimension table to collect information about the time and date operations were performed in Rational ClearCase.
	On the Designer File menu, point to New, and then click Time Dimension Table.

Alternatively, on the Designer toolbar, click Create Time Table.
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	4.2.12 
	Give the time dimension table a descriptive name.


	On the General tab, in the Name box, type “CCOperationDate.”
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	4.2.13 
	Save the CCOperationDate table. 
	On the Designer File menu, click Save.
	

	4.2.14 
	View the target fields for the CCOperationDate time dimension table, and then close the target table window.
	The Target Fields tab lists the fields that are automatically defined for the time dimension table. 

Close the CCOperationDate window.
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	4.2.15 
	To complete the warehouse schema setup, you need to create a measure table.  

A measure table consists of measures and references to dimension tables.  The references to the dimensions signify the attributes of a measure.
	On the Designer File menu, point to New, and then click Measure Table. 

Alternatively, on the Designer toolbar, click Create Measure Table.
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	4.2.16 
	Name the new measure table.

Tip  Although it is not required, using a naming convention for target tables is a good practice.  The convention used here is to append “_Measure” to designate a measure table.
	On the General tab, in the Name box, select the default name, and then type “CCChange_Measure.”

Click the Target Fields tab.
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	4.2.17 
	Create a reference field.
	The Target Fields tab lists the fields in the new measure table.

Click Add.
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	4.2.18 
	Specify the information for the new field
	In the Name box, type “name_fk.”

In the Type list, select Reference.

In the Reference list, select name_dim.

Leave the remaining default settings.

Click OK.
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	4.2.19 
	Define additional reference fields.
	Repeat steps 4.2.17 and 4.2.18 to create the following reference fields.  

Reference Field

Dimension Table

artifact_type_fk

artifact_type_dim

build_fk
Build_Dim
CCBranch_fk
CCBranch_Dim
CCOperation_fk

CCOperation_Dim

CCOperationDate_fk

CCOperationDate

CCVersion_fk

CCVersion_Dim

CCVob_fk

CCVob_Dim

owner_fk

owner_dim

project_fk

project_dim
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	4.2.20 
	Create an additive measure field.

Measures can be either additive or non-additive. The difference between additive and non-additive appears in trend charts.

Let’s say a feature X costs 1000 units (same value every day to simplify) and you collect its value every day. 

If the measure field in which this value is stored is additive, a trend chart, by week, of the cost of this feature will show 7000 per week. In this case, the trend chart shows the addition of all the values collected during the time interval. Since you collect daily, it shows 7 times 1000 for each week displayed on the chart.

If the measure field in which this value is stored is non-additive, a trend chart by week of the cost of this feature will show 1000 per week. In this case, the trend chart shows the latest value collected during the time interval specified. Because you collect daily, it shows the cost for the last day of the week of every week displayed on the chart.


	On the Target Fields tab, click Add.

In the Name box, type “CC Lines Changed.”

In the Type list, select Integer.

Clear the Non additive check box. 

Click OK. 
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	4.2.21 
	Create additional additive measure fields.
	Repeat step 1.2.21 to create two more additive fields named “CC Lines Deleted” and “CC Lines Inserted.”
	

	4.2.22 
	Each measure table that you create has a default existence measure field named “measure.”  Rename the existence measure field.
	On the Target Fields tab, in the Display Name column, click measure.

Click Edit.
	

	4.2.23 
	
	In the Name box, select the existing name (measure), and then type “CC Items.”

Leave all other default settings.

Click OK.
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	4.2.24 
	Save and close the measure table.
	You have created all the target fields you needed to collect Rational ClearCase data.

On the Designer File menu, click Save.

Alternatively, on the Designer toolbar, click Save.

Close the CCChange_Measure window.
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	4.2.25 
	To commit the warehouse schema changes you’ve made, you must check the schema in.
	On the Schema menu, click Check In. 

Alternatively, on the Designer toolbar, click Check In.
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	4.2.26 
	Add check-in comments.
	In the Comments box, you can type comments about the check-in.

Click OK.
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	4.2.27 
	Acknowledge the check-in of the schema.
	A Message window is displayed to let you know that the schema was successfully checked in. 

Click OK. 
	[image: image44.png]





Part 3 –  Populating a date/time dimension table

In your Rational ClearCase collection, one of the dimension tables is a time dimension table.  Time dimension tables are special dimension tables in that values for the dimension must be pre-populated with date information.  You can pre-populate the table using the Designer.

	
	Use Case Steps
	Details
	Display

	4.3.1 
	Populate the CCOperationDate time dimension table.

After you create a time dimension table and check in the schema, you must populate the time dimension table. To do this, specify a date range.  This populates the time dimensions, which the Dashboard uses to create trend charts.
	Click Time > Populate Time Dimension Table.
	[image: image45.png]File View Schema Task |Time Window Help






	4.3.2 
	Select the time dimension table you want to populate with data.
	In the Table Name list, select CCOperationDate.
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	4.3.3 
	Specify the first date to populate the table with.
	Next to Start Date, click the calendar button.
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	4.3.4 
	Populate the table starting with the date January 1, 2000.
	In the Month list, select January.

In the Year list, select 2000.

In the calendar dates section, click 1 (Saturday, the 1st).

Click OK.
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	4.3.5 
	Specify the last date to populate the table with.
	Next to End Date, click the calendar button.
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	4.3.6 
	
	In the Month list, select January.

In the Year list, select 2003.

In the calendar dates section, click 1 (Wednesday, the 1st).

Click OK.
	[image: image50.png]Select End Date

dauary 1, 2003

Worthlruery

Yearfzons =

sin | won | ot | wed [ | e sat

2 s 4

s s 7 s s 10 B

12 13 14 15 18 17 18

13 x 2 2 2 2 2
x 2 ) 2 E 3






	4.3.7 
	Now that you have set the date range for data collection, proceed to populate the time dimension table. 
	To populate the time dimension table, click OK.
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	4.3.8 
	Wait for the table to be populated.

Depending on the time interval you specify, populating the table can take time.

Here, you are populating the table with dates for three years, so it will take a few minutes.
	The Time Wizard opens. Its progress bar lets you know how the table population process is progressing.
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	4.3.9 
	Acknowledge that the time dimension table has been populated.
	A message lets you know the table is populated.
Click OK.
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Defining a mapping

In this exercise, you’ll define a mapping of the target fields in the Rational ProjectConsole data warehouse to the source fields in the Rational ClearCase text file.  The mapping gives Rational ProjectConsole the information about where to store collected data.
	
	Use case steps
	Details
	Display

	4.3.10 
	Define a mapping of the target fields in the data warehouse to the source fields.
	On the Designer File menu, point to New, and then click Mapping.

Alternatively, on the Designer toolbar, click Create Mapping.
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	4.3.11 
	Name the mapping.
	On the General tab, in the Name box, select the default mapping name, and then type “CC Mapping.”

Click the Mappings tab.
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	4.3.12 
	Defining the mapping fields. 

On the Mappings tab, you must first identify the measure table to populate.
	In the Target Table list, select CCChange_Measure.
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	4.3.13 
	
	The Target Field column lists the target fields for the CCChange_Measure table.
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	4.3.14 
	Select a source template.  
	In the Source Template list, select CC Template.
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	4.3.15 
	Identify the source field for each target field.  


	Click the Source Field column for the “Name” target field, and then, in the list, select name.  
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	4.3.16 
	Map the target fields to the source fields.
	Repeat step 4.4.6 to map the following fields:

Target Field
Source Field
artifact_ type

artifactType

CC Lines Changed

linesChanged

CC Lines Deleted

linesDeleted

CC Lines Inserted

linesInserted

CCBranch

branch

CCOperation

operation

CCOperationDate_name

operationDate

CCVersion

version

CCVOB

vob

owner

userName
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	4.3.17 
	Some target fields, such as the “project” field in this table, have no source, but you can still populate them by assigning them a default value.

Assign a default value to the project field.  
	Click in the Default Value column next to the “project” target field, type “Tutorial,” and then press enter.

Note  The “build” target field is also not mapped to a source field. You will assign it a value later.
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	4.3.18 
	Add default values.

Default values can also be added for target fields that are mapped, in case the corresponding source field has no value.

In this example, you will add default value to the measure fields of the table.
	Click the Default Value column next to the CC Lines Changed target field.

Type 0.
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	4.3.19 
	
	Repeat step 1.4.9 to assign a default value of 0 to the CC Lines Deleted and CC Lines Inserted fields.
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	4.3.20 
	Save and close the mapping.
	On the Designer File menu, click Save.

Close the mapping window.
	


Defining a collection task

In this exercise, you will create the Rational ClearCase collection task.

	
	Use Case Steps
	Details
	Display

	4.3.21 
	Now that you have defined a mapping, create a scheduled task for the Rational ClearCase collection.
	On the Designer File menu, point to New, and then click Scheduled Task.

Alternatively, on the Designer toolbar, click Create Scheduled Task.
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	4.3.22 
	Name the collection task and choose the host machine to run it.


	On the General tab, under Task Information, in the Name box, select the default name, and then type “CC Collection.”

Under Task Information, next to the Hostname box, click Select Hostname.
	[image: image67.png]Task1549276583 [Task]

Ganert | araneers | S|

Task Information

=10lx|

N [oc catector

Hastrame

Select Hastrame

Type of Task:

& Metrcs Colction

© other

Select Mapping

Select Task Tye






	4.3.23 
	
	In the Hostnames list, select <ProjectConsole Server>.

Click OK.
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	4.3.24 
	Specify the mapping to use in the collection task.
	The host machine name is displayed in the task window.

Under Type of Task, next to the Metrics Collection box, click Select Mapping.
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	4.3.25 
	
	In the Mappings list, select CC Mapping.

Click OK.
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	4.3.26 
	
	Click the Parameters tab.
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	4.3.27 
	A scheduled task with a mapping that points to a text source template has a single parameter named “SourceInstance.” The value for this parameter must be the fully qualified path to the text file from which data are to be collected.

Specify the fully qualified path to the text file that contains your sample data as the value for the SourceInstance parameter.
	Under Parameters, the Value field for the SourceInstance parameter contains “ccsample.txt.”  This was the text file used to construct the Rational ClearCase source template. 

You’ll use a different Rational ClearCase text file for this collection. 

Under Parameters:

· Double-click the Value column.

· Select the text “ccsample.txt,” and then type “C:\Classics\Projects \ProjectConsole\classicsCCdata.txt.” 
· Press enter.

Note   By default, the Value column displays the file name used in the source template. You must change this value each time you create a new scheduled task, unless your template text file is also the file from which you collect data.
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	4.3.28 
	Specifying a startup command. 

For these exercises, a sample text file containing Rational ClearCase data is provided. If you did not have this file, you would specify a startup command to extract data from the VOBs visible from your Rational ClearCase view and create the output file in the directory specified as the value of the “out” argument.
	This is an example of how you can specify a startup command to extract Rational ClearCase data to a text file. 

Note  Do not perform this step.

In the Startup Commands box, type the following command:

cqperl ClearCaseData.pl view=C:\snapshot_sample out= C:\Classics\Projects\ProjectConsole\ classicsCCdata.txt


	

	4.3.29 
	You can insert additional parameters that specify target fields that have no source fields mapped to them.  

In this example, the “Build” target field is not specified in the source. Here, you’ll specify it by adding it to the parameter list.
	Under Parameters, click Add.
	

	4.3.30 
	Specify Build 5 for the new parameter.
	In the Parameter name box, type “Build.”

In the Parameter Value box, type “Build 5.”

Click OK.
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	4.3.31 
	
	The Parameters table contains a new row.
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	4.3.32 
	You can specify a schedule for this task to cause the collection to run automatically on a daily, weekly, or monthly basis.  You can even specify the days on which the collection will run.  

For now, you will not set a schedule because you will run this task manually.

Save the task.
	On the Designer toolbar, click Save.

In the right pane, close the CC Collection [Task] task window.
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Part 4 –  Running a collection task

In this exercise, you will use the Designer to view and run the collection task that you created.

	
	Use case steps
	Details
	Display

	4.4.1 
	In the Designer, display the CC Collection task.


	In the Designer navigation tree, expand Scheduled Tasks, and then click CC Collection. 

The CC Collection [Task] window is displayed in the right pane.
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	4.4.2 
	Run the collection task.
	Click Task > Run.
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	4.4.3 
	Acknowledge that the task has started on your host machine.  
	The Designer displays a Task Scheduler window that advises you that the task run was started on your host machine.

Click OK.
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	4.4.4 
	The Designer creates a task run log. The log’s name consists of the scheduled task name with the start time and date appended.
	In the Designer navigation tree, click Scheduled Task Logs. The Scheduled Task Logs table opens in the right frame.
The first row should display the task name CC Collection_<start time>.

Double-click this row.
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	4.4.5 
	The task log shows the name of the machine running the collection, the run status, the start time, end time, and, if an error occurred during the collection, an error code and message.

You can manually refresh the log.

When SUCCESS is displayed in the Status box, the collection has completed 

The task log also shows the number of measures collected (the Rows Inserted box). In this example, you collected information for 1187 Rational ClearCase operations.
	If the Status box displays the value ACTIVE, on the View menu, click Refresh Selection periodically until the Status box displays the value SUCCESS.
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	4.4.6 
	Close the Designer.
	On your browser File menu, click Close.
	


Part 5 –  Viewing collection run results in the Rational ProjectConsole Dashboard

At this point, you have Rational ClearCase sample data stored in your data warehouse.  In this exercise, you will use the Dashboard to view the results in charts, gauges, indicators, and tables called “metric displays.”

	
	Use case steps
	Details
	Display

	4.5.1 
	From the main Rational ProjectConsole site, start the Dashboard.
	On the Rational ProjectConsole toolbar, click Dashboard.
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	4.5.2 
	
	The Dashboard starts in a new Web browser window.
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	4.5.3 
	Add a metrics panel in the Release 2.0 folder for the Webshop project.

A metrics panel is a container for one or more metrics displays.
	In the Designer navigation tree:

· Expand ClassicsCD.com Projects.

· Expand Webshop.

· Click Release 2.0.

· Right-click Release 2.0, and click New Metrics Panel.
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	4.5.4 
	
	A new Metrics Panel window is displayed in the right frame.
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	4.5.5 
	Add a chart to the metrics panel.
	On the Insert menu, click Chart.

Alternatively, on the Designer toolbar, click Insert Chart.
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	4.5.6 
	Specify the properties of the new chart.
	In the Chart Type list, select Distribution.

Under Available Fields:

In the Y-Axis list, select CC Lines Changed, CC Lines Deleted, and CC Lines Inserted.

In the X-Axis list, select owner.

Click OK.
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	4.5.7 
	You have created a chart showing the number of lines changed, deleted, and inserted, by owner.


	The chart is added to the metrics panel in the right frame.

To make the chart larger, in the lower right corner, drag the crosshairs down and to the right.
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	4.5.8 
	Change the chart type displayed.
	Right-click the chart, and click Display Type > Stack Bar Chart on the shortcut menu.
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	4.5.9 
	
	The regenerated stack bar chart is displayed.
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	4.5.10 
	You can filter the data displayed in a chart based on any attribute.

In this example, look at only checkin and mkelem operations.
	Right-click the chart, and click Properties. 
	

	4.5.11 
	Select an attribute by which to filter the Rational ClearCase data displayed in the chart.
	Under Current Selection, click Filters.
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	4.5.12 
	Select the owner field and specify the value to filter out.
	Under Select Field, double-click owner. 

The owner field is in the Define Filters table.
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	4.5.13 
	Change the operator value to IN (not equal to).
	In the Define Filters table, in the Operator list, scroll to and select IN.  
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	4.5.14 
	Specify the filtered values for the Operator field. 
	Click Values.
	

	4.5.15 
	
	In the list of values, select alex, chris, devon and jan.
Click OK.
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	4.5.16 
	The Filters window shows the values selected.
	The Value column displays the values you selected.
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	4.5.17 
	Regenerate the chart.
	The Properties window for the chart shows the filter you just added.

The Current Selection list displays the filter information you specified.

Click OK.
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	4.5.18 
	View the regenerated chart.

Note  The chart looks exactly as it did before you added the filter. This is because the number of lines inserted, deleted, and changed is updated by the check-in operations only. 
	The updated distribution chart is displayed in the metrics panel.
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	4.5.19 
	Save your distribution chart and close the Designer.
	On the Designer File menu, click Save.

Close the browser window.
	


Conclusion

Congratulations!  You have successfully populated your data warehouse with Rational ClearCase metrics.  Let’s review what you did.

You used the Rational ProjectConsole Designer to:

Identify a text file from which to collect data. 
Create a text source template to identify the artifacts to be collected.  You specified the Rational ClearCase artifact name, operation, operation date, branch, version, VOB, lines inserted, lines deleted, and lines changed as the attributes of a Rational ClearCase artifact to collect.

Create the warehouse measure and dimension tables in which to store the artifacts.  You defined dimension tables for the attributes and a measure table containing relationships to the attributes (dimension tables). You also created a time dimension table and populated it with data.

Define a mapping to indicate where to store the source artifact attributes.  

Create a collection task (the fourth step in the process).  You identified the host machine to run the collection and specified the mapping to use for the collection task.

Run the Rational ClearCase collection task.

You use the Rational ProjectConsole Dashboard to:

Create a metrics panel.

Add a distribution chart to the metrics panel to view your collection results. 
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